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 D-Link AirPremierTM DWL-3200AP 
  Managed Wireless Access Point 
 
 Power over Ethernet base unit 

 Power Adapter-DC 48V, 0.4A

 Power Cord

 Manual and Warranty on CD

 Quick Installation Guide
 
 Ethernet Cable

Package Contents 

Minimum System Requirements 

Note: Using a power supply  with a different voltage than the one included with the 
DWL-3200AP will cause damage and void the warranty for this product.

If any of the above items are missing, please contact your reseller.

 Computers with Windows®, Macintosh®, or Linux-based operating systems with 
an  installed Ethernet Adapter

 Internet Explorer version 6.0 or Netscape Navigator™ version 7.0 and above

Package Contents

 Mounting Plate
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At up to fifteen times the speed of previous wireless devices (maximum wireless signal 
rate of up to 108Mbps* in Super G mode), you can work faster and more efficiently, 
increasing productivity. With the DWL-3200AP, bandwidth-intensive applications like 
graphics or multimedia will benefit significantly because large files are able to move 
across the network quickly.

The DWL-3200AP is capable of operating in one of 3 different wireless networking 
modes; access point, WDS (Wireless Distribution System) with AP, or WDS mode.

Use less wiring, enjoy increased flexibility, save time and money with PoE (Power over 
Ethernet). With PoE, the DWL-3200AP shares power and data over the CAT5 cable, 
making the setup of your network less expensive and more convenient.

An ideal solution for quickly creating and extending a wireless local area network 
(WLAN) in offices or other workplaces, trade shows and special events, the DWL-3200AP 
provides data transfers at up to 108Mbps in Super G mode when used with other 
D-Link AirPremier products. (The 802.11g standard is backwards compatible with 
802.11b devices.)  

Introduction 
Introduction

*”Maximum wireless signal rate derived from IEEE Standard 802.11g specifications. Actual data throughput will vary. Network 
conditions and environmental factors, including volume of network traffic, building materials and construction, and network overhead 
lower actual data throughout rate.”

WPA is offered in two flavors: Enterprise (used for corporations) and Personal (used 
for home users).

WPA-Personal and WPA2-Personal is directed at home users who do not have the 
server based equipment required for user authentication. The method of authentication 
is similar to WEP because you define a “Pre-Shared Key” on the wireless router/AP. 
Once the pre-shared key is confirmed and satisfied on both the client and access point, 
then access is granted. The encryption method used is referred to as the Temporal Key 
Integrity Protocol (TKIP), which offers per-packet dynamic hashing. It also includes an 
integrity checking feature which ensures that the packets were not tampered with during 
wireless transmission. WPA2-Personal is far superior to WPA-Personal, because the 
encryption of data is upgraded with the Advanced Encryption Standard (AES).
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802.1x: Authentication which is a first line of defense against intrusion. In the 
authentication process, the Authentication Server verifies the identity of the client 
attempting to connect to the network. Unfamiliar clients would be denied access.

EAP (Extensible Authentication Protocol) is available through the Windows® XP 
operating system. You will need to use the same type of EAP protocol on all devices in 
your network when using the 802.1x feature.

WPA-Enterprise and WPA2-Enterprise is ideal for businesses that have existing 
security infrastructures in place. Management and security implementation can now 
be centralized on a server participating on the network. Utilizing 802.1x with a RADIUS 
(Remote Authentication Dial-in User Service) server, a network adminstrator can define 
a list of authorized users who can access the wireless LAN. When attempting to access 
a wireless LAN with WPA-Enterprise or WPA2-Enterprise configured, the new client will 
be challenged with a username and password. If the new client is authorized by the 
administration, and enters the correct username and password, then access is granted. 
In a scenario where an employee leaves the company, the network administrator can 
remove the employee from the authorized list and not have to worry about the network 
being compromised by a former employee. WPA2-Enterprise is far superior to 
WPA-Enterprise, because the encryption of data is upgraded with the Advanced 
Encryption Standard (AES).

Introduction
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 3 Different Operation modes -  Capable of operating in one of three different 
operation modes to meet your wireless networking requirements: Access Point; 
WDS with AP, or WDS.

 Easy Installation with PoE (Power over Ethernet).

 Faster wireless networking with the 802.11g standard to provide a maximum 
wireless signal rate of up to 54Mbps* (maximum wireless signal rate of up to 
108Mbps* in Super G mode).

 Compatible with the 802.11b standard to provide a wireless data rate of up to 
11Mbps - that means you can migrate your system to the 802.11g standard on 
your own schedule without sacrificing connectivity.

 Better security with WPA - The DWL-3200AP can securely connect wireless 
clients on the network using WPA (Wi-Fi Protected Access) providing a much 
higher level of security for your data and communications than has previously 
been available.

 AP Manager Setup Wizard - The new Setup Wizard makes network 
configuration quick and simple.

 SNMP for Management - The DWL-3200AP is not just fast but it also supports 
SNMP v.3 for a better network management. Superior wireless AP manager 
software is bundled with the DWL-3200AP for network configuration and 
firmware upgrade. Systems administrators can also setup the DWL-3200AP 
easily with the Web-based configuration. A D-Link D-View module will be 
downloadable for network administration and real-time network traffic monitoring 
with D-Link D-View software.

 Utilizes OFDM technology (Orthogonal Frequency Division Multiplexing).

 Operates in the 2.4GHz frequency range.

 Web-based interface for managing and configuring.

Features and Benefits 
Features and Benefits

*”Maximum wireless signal rate derived from IEEE Standard 802.11a and 802.11g specifications. Actual data throughput will 
vary. Network conditions and environmental factors, including volume of network traffic, building materials and construction, and 
network overhead lower actual data throughout rate.”
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Wireless Basics

D-Link wireless products are based on industry standards to provide easy-to-use and 
compatible high-speed wireless connectivity within your home, business or public 
access wireless networks. D-Link wireless products will allow you access to the data you 
want, when and where you want it. You will be able to enjoy the freedom that wireless 
networking brings.

A Wireless Local Area Network (WLAN) is a computer network that transmits and 
receives data with radio signals instead of wires. WLANs are used increasingly in both 
home and office environments, and public areas such as airports, coffee shops and 
universities. Innovative ways to utilize WLAN technology are helping people to work 
and communicate more efficiently. Increased mobility and the absence of cabling and 
other fixed infrastructure have proven to be beneficial for many users. 

People use WLAN technology for many different purposes:

Mobility - Productivity increases when people have access to data in any location 
within the operating range of the WLAN. Management decisions based on real-time 
information can significantly improve worker efficiency.

Low Implementation Costs - WLANs are easy to set up, manage, change and relocate. 
Networks that frequently change can benefit from WLANs ease of implementation. 
WLANs can operate in locations where installation of wiring may be impractical.

Installation and Network Expansion - Installing a WLAN system can be fast and easy 
and can eliminate the need to pull cable through walls and ceilings. Wireless technology 
allows the network to go where wires cannot go - even outside the home or office.

Inexpensive Solution - Wireless network devices are as competitively priced as 
conventional Ethernet network devices. The DWL-3200AP saves money by providing 
multi-functionality, configurable in one of four different modes.

Scalability - WLANs can be configured in a variety of ways to meet the needs of 
specific applications and installations. Configurations are easily changed and range 
from Peer-to-Peer networks suitable for a small number of users to larger Infrastructure 
networks to accommodate hundreds or thousands of users, depending on the number 
of wireless devices deployed.

Wireless users can use the same applications they use on a wired network. Wireless 
adapter cards used on laptop and desktop systems support the same protocols as 
Ethernet adapter cards. 

Wireless Basics
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Standards-Based Technology

The DWL-3200AP Managed Wireless Access Point utilizes the 802.11b and the 802.11g 
standards.

The IEEE 802.11g standard is an extension of the 802.11b standard. It increases the 
maximum wireless signal rate of up to 54Mbps* (maximum wireless signal rate of up 
to 108Mbps* in Super G mode) within the 2.4GHz band, utilizing OFDM technology.

This means that in most environments, within the specified range of this device, you will 
be able to transfer large files quickly or even watch a movie in MPEG format over your 
network without noticeable delays. This technology works by transmitting high-speed 
digital data over a radio wave utilizing OFDM (Orthogonal Frequency Division Multiplexing) 
technology. OFDM works by splitting the radio signal into multiple smaller sub-signals 
that are then transmitted simultaneously at different frequencies to the receiver. OFDM 
reduces the amount of crosstalk (interference) in signal transmissions. 

The D-Link DWL-3200AP will automatically sense the best possible connection speed 
to ensure the greatest speed and range possible.

802.11g offers the most advanced network security features available today, including 
WPA and WPA2.

Wireless Basics

*”Maximum wireless signal rate derived from IEEE Standard 802.11g specifications. Actual data throughput will vary. Network 
conditions and environmental factors, including volume of network traffic, building materials and construction, and network overhead 
lower actual data throughout rate.”
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Wireless Basics

The D-Link AirPremier DWL-3200AP lets you access your network, using a wireless 
connection, from virtually anywhere within its operating range. Keep in mind, however, 
that the number, thickness and location of walls, ceilings, or other objects that the 
wireless signals must pass through, may limit the range. Typical ranges vary depending 
on the types of materials and background RF (radio frequency) noise in your home or 
business. The key to maximizing wireless range is to follow these basic guidelines:

Keep your product away (at least 3-6 feet or 1-2 meters) from electrical devices or 
appliances that generate RF noise.

4 

Keep the number of walls and ceilings between the DWL-3200AP and other network 
devices  to a minimum - each wall or ceiling can reduce your DWL-3200AP’s range 
from 3-90 feet (1-30 meters.) Position your devices so that the number of walls or 
ceilings is minimized.

1

Be aware of the direct line between network devices. A wall that is 1.5 feet thick      
(.5 meters), at a 45-degree angle appears to be almost 3 feet (1 meter) thick. At a                   
2-degree angle it looks over 42 feet (14 meters) thick! Position devices so that the 
signal will travel straight through a wall or ceiling (instead of at an angle) for better 
reception.

2

Building materials can impede the wireless signal - a solid metal door or aluminum  
studs may have a negative effect on range. Try to position wireless devices and 
computers with wireless adapters so that the signal passes through drywall or open 
doorways and not other materials.

3

Installation Considerations
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Three Operational Modes
Three Operational Modes
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Getting Started

Consult with your Cable or DSL provider for proper installation of the modem.

Connect the Cable or DSL modem to a Router. 
(See the printed Quick Installation Guide included with your router.)

If you are connecting a desktop computer to your network, install the D-Link    
DWL-G520 wireless PCI adapter into an available PCI slot on your desktop 
computer.
(See the printed Quick Installation Guide included with the network adapter.)

Install the drivers for the D-Link DWL-G650 wireless Cardbus adapter into a 
laptop computer. 
(See the printed Quick Installation Guide included with the DWL-G650.)

Connect the DWL-3200AP to the PoE base unit. 
(See the printed Quick Installation Guide included with the DWL-3200AP.)

Connect the Ethernet Broadband Router to the PoE base unit. 
(See the printed Quick Installation Guide included with the DWL-3200AP.)

2

3

4

5

6

7

You will need broadband Internet access.1

Getting Started
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Getting Started

Connecting PoE (Power over Ethernet)

Connect one end of an Ethernet cable (included with your package) to 
the LAN port on the DWL-3200AP and the other end of the Ethernet 
cable to the port labeled P+DATA OUT on the PoE base unit.

Connect another Ethernet cable from the DATA IN port on the PoE 
base unit to your router/switch, using a straight through cable, or to 
a PC, using a crossover cable. 

Attach the power adapter to the connector labeled POWER IN on 
the PoE base unit. Attach the power cord to the power adapter and 
into an electrical outlet.    

Step 1

Step 2

Step 3
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Using the Configuration Menu 
Using the Configuration Menu

To configure the DWL-3200AP, use a computer which is connected to the DWL-3200AP 
with an Ethernet cable (see the Network Layout diagram).

First, disable the Access the Internet using a proxy server function. To disable this 
function, go to Control Panel > Internet Options > Connections > LAN Settings 
and uncheck the enable box.  

Start your web browser program (Internet Explorer, Netscape Navigator™) . 

Type the IP address and http port of the DWL-3200AP in the address field           
(http://192.168.0.50) and press Enter. Make sure that the IP addresses of the 
DWL-3200AP and your computer are in the same subnet.

After the connection is established, you will see the user identification window as 
shown. 
Note: If you have changed the default IP address assigned to the DWL-3200AP, make sure to 
enter the correct IP address. 

   

        

     





 Type admin in the User Name field

Leave the Password field blank

Click OK

Note: If you have changed the password, make sure to enter the correct password.
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Using the Configuration Menu

The Home>Wizard screen will appear. Please refer to the Quick Installation Guide for 
more information regarding the Setup Wizard.

These buttons appear on most of the configuration screens in this section. Please 
click on the appropriate button at the bottom of each screen after you have  made a 
configuration change.

Home > Wizard
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Using the Configuration Menu

Home > Wireless > AP mode

Access Point is selected from the pull-down menu.

Service Set Identifier (SSID) is the name designated for a specific 
wireless local area network (WLAN). The SSID’s factory default 
setting is default. The SSID can be easily changed to connect to an 
existing wireless network or to establish a new wireless network.

Enable or Disable SSID broadcast. Enabling this feature broadcasts 
the SSID across the network.

6 is the default channel. All devices on the network must share the 
same channel. (Note: The wireless adapters will automatically scan 
and match the wireless setting.) 

Mode:

SSID:

SSID Broadcast:

Channel:

Wireless Band: IEEE 802.11g 
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Auto Channel 
Scan:

Authentication:

Select Enable or Disable. (Enable this feature to auto-select the  
channel for best wireless performance.)

Open System
Shared Key
Open System/Shared Key
WPA-Enterprise
WPA-Personal
WPA2-Enterprise
WPA2-Personal
WPA-Auto-Enterprise
WPA-Auto-Personal 

Home > Wireless > AP mode (continued)

Select Open System to communicate the key across the 
network.
Select Shared Key to limit communication to only those devices 
that share the same WEP settings.
Select Open System/Shared Key to allow either form of data 
encryption.
Select WPA-Enterprise, WPA2-Enterprise, WPA-Auto-Enterprise 
to secure your network with the inclusion of a RADIUS server.
Select WPA-Personal, WPA2-Personal, WPA-Auto-Personal to 
secure your network using a password and dynamic key changes. 
(No RADIUS server required).

Using the Configuration Menu

Radio:

Super G Mode:

Select On or Off. 

Super G is a group of performance enhancement features that 
increase end user application throughput in an 802.11g network. 
Super G is backwards compatible to standard 802.11g devices. 
For top performance, all wirelss devices on the network should be 
Super G capable. Select either Disabled, Super G without Turbo, 
or Super G with Dynamic Turbo.

Disabled: Standard 802.11g support, no enhanced capabilities.

Super G 
without 

Turbo: 
Capable of Packet Bursting, FastFrames, Compression, 
and no Turbo mode.

Super 
G with 

Dynamic 
Turbo:

Capable of Packet Bursting, FastFrames, Compression, 
and Dynamic Turbo. This setting is backwards compatible 
with non-Turbo (legacy) devices. Dynamic Turbo mode is 
only enabled when all devices on the wireless network are 
configured with Super G with Dynamic Turbo enabled.
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Valid Key:

First through 
Fourth keys:

Home > Wireless > AP mode > WEP Encryption

Encryption: Select Disabled or Enabled. (Disabled is selected here).
     

Key Type*: 

Key Size:

Input up to four keys for encryption. You will select one of these 
keys in the valid key field.
     

*Hexadecimal digits consist of the numbers 0-9 and the letters A-F

*ASCII (American Standard Code for Information Interchange) is a code for 
representing English letters as numbers from 0-127

Select HEX or ASCII.
     

Select 64-, 128-, 152-bits.
     
Select the 1st through the 4th key to be the active key.
     

Using the Configuration Menu
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Home > Wireless > AP mode > WPA-Enterprise, WPA2-Enterprise, 
& WPA-Auto-Enterprise

Cipher Type: 

Group Key Update 
Interval: 

When you select WPA-Enterprise, you must select AUTO, AES, or 
TKIP from the pull down menu.

Select the interval during which the group key will be valid. 
1800 is the recommended value. A lower interval may reduce data 
transfer rate.

Radius Server: Enter the IP address of the Radius server.

Radius Port: Enter the Radius port.

Radius Secret: Enter the the Radius secret.

Using the Configuration Menu
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Home > Wireless > AP mode > WPA-Personal, WPA2-Personal, 
& WPA-Auto-Personal

Cipher Type:

Group Key Update 
Interval: 

Select the interval during which the group key wll be valid. The default 
value of 1800 is recommended.

When you select WPA-Personal, please select AUTO, AES, or TKIP 
from the pull down menu.

PassPhrase: When you select WPA-Personal, please enter a PassPhrase in the 
corresponding field.

Using the Configuration Menu



20

DWL-3200AP User’s Manual 

D-Link Systems, Inc.

Home > Wireless > WDS with AP mode 

WDS with AP mode is selected from the pull-down menu.

Service Set Identifier (SSID) is the name designated for a specific 
wireless local area network (WLAN). The SSID’s factory default 
setting is default. The SSID can be easily changed to connect to an 
existing wireless network or to establish a new wireless network.

Enable or Disable SSID broadcast. Enabling this feature broadcasts 
the SSID across the network.

6 is the default channel. All devices on the network must share the 
same channel. (Note: The wireless adapters will automatically scan 
and match the wireless setting.) 

Mode:

SSID:

SSID Broadcast:

Channel:

Wireless Band: IEEE 802.11g 

In WDS with AP mode, the DWL-3200AP wirelessly connects multiple networks, while 
still functioning as a wireless AP.

Using the Configuration Menu
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Home > Wireless > WDS with AP mode (continued) 
Auto Channel 

Scan:

Remote AP MAC 
Address:

Select Enable or Disable. (Enable this feature to auto-select the  
channel for best wireless performance.)

Enter the MAC addresses of the APs in your network that will serve 
as bridges to wirelessly connect mulitple networks.

Authentication:

Encryption: Select Disabled or Enabled. (Disabled is selected here).
     

Key Type*: 

Key Size:

Input up to four keys for encryption. You will select one of these 
keys in the valid key field.
     

Select HEX or ASCII.
     

Select 64-, 128-, 152-bits.
     
Select the 1st through the 4th key to be the active key.
     

Valid Key:

First through 
Fourth keys:

Open System
Shared Key
Open System/Shared Key
WPA-Personal
WPA2-Personal
WPA-Auto-Personal 

Select Open System to communicate the key across the network.
Select Shared Key to limit communication to only those devices that 
share the same WEP settings.
Select Open System/Shared Key to allow either form of data      
encryption.
Select WPA-Personal, WPA2-Personal, or WPA-Auto-Personal to 
secure your network using a password and dynamic key changes.
(No RADIUS Server required).

Home > Wireless > WDS with AP mode > WEP Encryption

*Hexadecimal digits consist of the numbers 0-9 and the letters A-F

*ASCII (American Standard Code for Information Interchange) is a code for 
representing English letters as numbers from 0-127

Using the Configuration Menu
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Home > Wireless > WDS with AP mode > WPA-Personal, 
WPA2-Personal, & WPA-Auto-Personal

Cipher Type:

Group Key Update 
Interval: 

Select the interval during which the group key wll be valid. The 
default value of 1800 is recommended, a lower interval may reduce 
the data transfer rate.

When you select WPA-Personal, AES is used here.

PassPhrase: When you select WPA-Personal, please enter a PassPhrase in the 
corresponding field.

Using the Configuration Menu
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Home > Wireless > WDS mode

In WDS mode, the DWL-3200AP wirelessly connects multiple networks, without 
functioning as a wireless AP.

WDS is selected from the pull-down menu.

Service Set Identifier (SSID) is the name designated for a specific 
wireless local area network (WLAN). The SSID’s factory default 
setting is default. The SSID can be easily changed to connect to an 
existing wireless network or to establish a new wireless network.

Mode:

SSID:

Wireless Band: IEEE 802.11g 

Using the Configuration Menu
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Home > Wireless > WDS mode (continued) 
SSID Broadcast:

Channel:

Auto Channel 
Scan:

Remote AP MAC 
Address:

Enable or Disable SSID broadcast. Enabling this feature broadcasts 
the SSID across the network.

6 is the default channel. All devices on the network must share the 
same channel. (Note: The wireless adapters will automatically scan 
and match the wireless setting.) 

Select Enable or Disable. (Enable this feature to auto-select the  
channel for best wireless performance.)

Enter the MAC addresses of the APs in your network that will serve 
as bridges to wirelessly connect mulitple networks.

Authentication:

Encryption: Select Disabled or Enabled. (Disabled is selected here).
     

Key Type*: 

Key Size:

Input up to four keys for encryption. You will select one of these 
keys in the valid key field.
     

Select HEX or ASCII.
     

Select 64-, 128-, 152-bits.
     
Select the 1st through the 4th key to be the active key.
     

Valid Key:

First through 
Fourth keys:

Select Open System to communicate the key across the network.
Select Shared Key to limit communication to only those devices that 
share the same WEP settings.
Select Open System/Shared Key to allow either form of data      
encryption.
Select WPA-Personal, WPA2-Personal, or WPA-Auto-Personal to 
secure your network using a password and dynamic key changes.
(No RADIUS Server required).

Open System
Shared Key
Open System/Shared Key
WPA-Personal
WPA2-Personal
WPA-Auto-Personal 

*Hexadecimal digits consist of the numbers 0-9 and the letters A-F

*ASCII (American Standard Code for Information Interchange) is a code for 
representing English letters as numbers from 0-127

Home > Wireless > WDS mode > WEP

Using the Configuration Menu
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Home > Wireless > WDS mode > WPA-Personal, WPA2-Personal, 
& WPA-Auto-Personal

Cipher Type:

Group Key Update 
Interval: 

Select the interval during which the group key wll be valid. The 
default value of 1800 is recommended, a lower interval may reduce 
the data transfer rate.

When you select WPA-Personal, AES is used here.

PassPhrase: When you select WPA-Personal, please enter a PassPhrase in the 
corresponding field.

Using the Configuration Menu
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Access Point

WDS with AP

WDS

Open System
Shared Key
Open System/Shared Key
WPA-Enterprise
WPA-Personal
WPA2-Enterprise
WPA2-Personal
WPA-Auto-Enterprise
WPA-Auto-Personal

Open System
Shared Key
Open System/Shared Key
WPA-Personal
WPA2-Personal
WPA-Auto-Personal

Open System
Shared Key
Open System/Shared Key
WPA-Personal
WPA2-Personal
WPA-Auto-Personal

AP Mode Authentication Available

Home > Wireless Modes

Using the Configuration Menu
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Static (Manual) is chosen here. Choose this option if you do not have 
a DHCP server in your network, or if you wish to assign a static IP 
address to the DWL-3200AP. When DHCP is selected the other fields 
here will be greyed out.

The default IP address is 192.168.0.50. Assign a static IP address 
that is within the IP address range of your network.

Enter the subnet mask. All devices in the network must share the 
same subnet mask.

Enter the IP address of the gateway in your network. If there isn’t 
a gateway in your network, please enter an IP address within the 
range of your network.

Home > LAN 

Using the Configuration Menu

Get IP From:

IP Address:

Subnet Mask:

Default Gateway:

 

LAN is short for Local Area Network. This is considered your internal network. These 
are the IP settings of the LAN interface for the DWL-3200AP. These settings may be 
referred to as private settings. You may change the LAN IP address if needed. The LAN 
IP address is private to your internal network and cannot be seen on the Internet.
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Using the Configuration Menu

Advanced > Performance

Wireless Band:

Data Rate:*

Beacon Interval:

IEEE 802.11g

The Data Rates are Auto, 1Mbps, 2Mbps, 5.5Mbps, 6Mbps, 9Mbps, 
11Mbps, 12Mbps, 18Mbps, 24Mbps, 36Mbps, 48Mbps, 54Mbps.

Beacons are packets sent by an access point to synchronize a 
network. Specify a beacon interval value. The default (100) is 
recommended.

*”Maximum wireless signal rate based on IEEE Standard 802.11a and 802.11g specifications. Actual data throughput will vary. 
Network conditions and environmental factors, including volume of network traffic, building materials and construction, and network 
overhead lower actual data throughout rate.”
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Using the Configuration Menu

DTIM:

Fragment Length:

RTS Length:

Transmit Power:

(Delivery Traffic Indication Message) - Select  a setting between 1and 
255. 1 is the default setting. DTIM is a countdown informing clients of 
the next window for listening to broadcast and multicast messages.

The fragmentation threshold, which is specified in bytes, determines 
whether packets will be fragmented. Packets exceeding the 2346 
byte setting will be fragmented before transmission. 2346 is the 
default setting 

This value should remain at its default setting of 2346. If you 
encounter inconsistent data flow, only minor modifications to the 
value range between 256 and 2346 are recommended

Choose full, half (-3dB), quarter (-6dB), eighth (-9dB), minimum 
power.

802.11g only: For increased speed in your network, enable this option. 802.11b 
devices will be excluded.

WMM: Select Enable or Disable, Disable is selected by default. WMM 
stands for Wi-Fi Multimedia, by enabling this feature it will improve 
the user experience for audio and video applications over a Wi-Fi 
network. 

Praemble: Select the default value Short and Long, or Long Only.
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Using the Configuration Menu

Advanced > Filters > Wireless Access Settings

Wireless Band:

Access Control:

MAC Address:

MAC Address List:

IEEE 802.11g 

Enter the MAC addresses that you wish to include in your filters 
list, and click Save.

When you enter a MAC address, it appears in this list. Highlight a 
MAC address and click Delete to remove it from the list.

Select Disabled to disable the filters function.
Select Accept to accept only those devices with MAC addresses 
in the Access Control List.
Select Reject to reject the devices with MAC addresses in the 
Access Control List.
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Using the Configuration Menu

Advanced > Filters > WLAN Partition

Wireless Band: 

Internal Station 
Connection:

Ethernet to WLAN 
Access:

IEEE 802.11g

Enabling this feature allows wireless clients to communicate with 
each other. If this is disabled, wireless stations of the selected band 
are not allowed to exchange data through the access point.

Enabling this feature allows Ethernet devices to communicate with 
wireless clients. If this is disabled, all data from the Ethernet to 
associated wireless devices is blocked. Wireless devices can still 
send data to the Ethernet.
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DHCP Server 
Control:

IP Assigned From:
 

Dynamic Host Configuration Protocol assigns dynamic IP 
addresses to devices on the network. This protocol simplifies 
network management and allows new wireless devices to receive 
IP addresses automatically without the need to manually assign 
new IP addresses.
Select Enable to allow the DWL-3200AP to function as a DHCP 
server.

Enter the number of IP addresses available for assignment.The Range of Pool 
(1-255):

Using the Configuration Menu

Advanced > DHCP Server > Dynamic Pool Settings

Input the first IP address available for assignment in your network.     



33

DWL-3200AP User’s Manual 

D-Link Systems, Inc.

Using the Configuration Menu

SubMask:

Gateway:

Wins:

DNS:

Domain Name:

Lease Time 
(60-31536000 

sec.):

Status:

All devices in the network must have the same subnet mask to 
communicate. Enter the submask for the network here.

Enter the IP address of the gateway on the network.

Windows Internet Naming Service is a system that determines the 
IP address of a network computer that has a dynamically assigned 
IP address.

Enter the IP address of the DNS server. The DNS (Domain Name 
Server) translates domain names such as www.dlink.com into IP 
addresses.

Enter the domain name of the DWL-3200AP, if applicable. (An 
example of a domain name is: www.dlink.com.)

The Lease Time is the period of time before the DHCP server will 
assign new IP addresses.

Turn the Dynamic Pool Settings ON or OFF here.

Advanced > DHCP Server > Dynamic Pool Settings (continued)
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Using the Configuration Menu

Advanced > DHCP Server > Static Pool Settings

DHCP Server 
Control:

Assigned IP:

Assigned MAC 
Address:

SubMask:

Gateway:
 

Dynamic Host Configuration Protocol assigns IP addresses to 
wireless devices on the network. This protocol simplifies network 
management and allows new wireless devices to receive IP 
addresses automatically without the need to manually assign IP 
addresses.
Select Enable to allow the DWL-3200AP to function as a DHCP 
server. 

Use the Static Pool Settings to assign the same IP address to a 
device at every restart. The IP addresses assigned in the Static Pool  
list must NOT be in the same IP range as the Dynamic Pool. After you 
have assigned a static IP address to a device via its MAC address, 
click Apply; the device will appear in the Assigned Static Pool at 
the bottom of the screen. Edit or delete the device in this list.

Enter the MAC address of the device here.

Enter the subnet mask here.

Enter the IP address of the gateway on the network.
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Windows Internet Naming Service is a system that determines 
the IP address of a network computer with a dynamically assigned 
IP address, if applicable.

Enter the IP address of the Domain Name Server, if applicable. 
The DNS translates domain names such as www.dlink.com into IP 
addresses.

Wins:

DNS:

Domain Name:

Status:

 

Enter the domain name of the DWL-3200AP, if applicable.

This option turns the Static Pool settings ON or OFF.

Using the Configuration Menu

Advanced > DHCP Server > Current IP Mapping List

These are IP address pools to which the DHCP server function has 
assigned dynamic IP addresses. 

This screen displays information about the current DHCP dynamic and static IP 
address pools. This information is available when you enable the DHCP function of the                   
DWL-3200AP and assign dynamic and static IP address pools.

Current DHCP 
Dynamic Pools:
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Using the Configuration Menu

Binding MAC 
address:

Assigned IP address:

Lease Time:

Current DHCP Static 
Pools:

Binding MAC 
address:

Assigned IP address:

 

The MAC address of a device on the network that is within the DHCP 
dynamic IP address pool.

The current corresponding DHCP-assigned dynamic IP address of 
the device.

The length of time that the dynamic IP address will be valid.

These are IP address pools to which the DHCP server function has 
assigned static IP addresses. 

The MAC address of a device on the network that is within the DHCP 
static IP address pool.

The current corresponding DHCP-assigned static IP address of the 
device.

Advanced > DHCP Server > Current IP Mapping List 
(continued)
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Using the Configuration Menu

Advanced > Multi-SSID

If you want to configure the Guest and Internal networks on Virtual LAN (VLANs), the 
switch and DHCP server you are using must suppport VLANs. As a prerequisite step, 
configure a port on the switch for handling VLAN tagged packets as described in the 
IEEE802.1Q standard.
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Using the Configuration Menu

Advanced > Multi-SSID (continued)

Index:

SSID:

 Security:

VLAN Group ID:

 

Key Type:

Key Size:

Key:

The Master SSID and Security can not be changed here. Those  
values follow the settings in Home>Wireless.

When you Enable Multi-SSID you can name each guest SSID. 

The Security options for these seven Guest SSIDs are None, 
Open System or Shared Key, WPA-Enterprise, WPA-Personal, 
WPA2-Enterprise, WPA2-Personal, WPA-Auto-Enterprise, and 
WPA-Auto-Personal

If you configure enable Guest access and configure Internal and 
Guest networks on VLANs, this field will be enabled.

Provide a number between 1 and 4094 for the Internal VLAN.

This will cause the access point to send DHCP requests with the 
VLAN tag. The switch and the DHCP server must support VLAN 
IEEE802.1Q frames. The access point must be able to reach the 
DHCP server.

Check with the Administrator regarding the VLAN and DHCP 
configurations.

Select HEX or ASCII if you are using WEP encryption.

Select 64-, 128-, 152-bits

Select the 1st through the 4th key to be the active key. Enter the 
key here. 

Note: If any of the SSID uses WPA, WPA2, WPA-Auto, it will take 
the space of key2 and key3. The rest can only use key1, key4, no 
security, or use WPA also.

Advanced > Multi-SSID > WEP Encryption
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Advanced > Multi-SSID > WPA-Personal, WPA2-Personal, & 
WPA-Auto-Personal

Cipher Type:

Group Key Update 
Interval: 

Select the interval during which the group key wll be valid. The default 
value of 1800 is recommended.

When you select WPA-Personal, please select AUTO, AES, or TKIP 
from the pull down menu.

PassPhrase: When you select WPA-Personal, please enter a PassPhrase in the 
corresponding field.

Using the Configuration Menu
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Advanced > Rogue AP

The Basic Service Set Type allows you to select from AP BSS, Ad 
Hoc, or Both. 

Select the type of network (bands 11b and 11g) that you would like 
the AP detection to search on. 

BSS Type:

Band:

Using the Configuration Menu
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Advanced > Rogue AP (continued)

Select the Security type OFF, WEP, WPA-Enterprise, WPA-Personal, 
WPA2-Enterprise, WPA2-Personal, WPA-Auto-Enterprise, and  
WPA-Auto-Personal that you would like to consider during AP 
detection.

This window shows all of the neighbor APs detected, which is based 
on your criteria from above (BSS Type, Band, and Security). If the 
AP is in the same network, or if you know the AP, just click on “Add” 
to save it to the AP list.

This window shows all of the APs that are allowed access on the 
network.

Security:

Rogue AP List:

AP List:

Using the Configuration Menu
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Tools > Admin

User Name:

Old Password:

New Password:

Confirm New 
Password:

Enter a user name. The default setting is admin.

To change your password, enter the old password here.

Enter your new password here.

Enter your new password again.

Using the Configuration Menu
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Apply Settings and 
Restart:

Restore to Factory 
Default Settings:

 

Click Restart to apply the system settings and restart the 
DWL-3200AP.

Click Restore to return the DWL-3200AP to its factory default 
settings.

Tools > System

Using the Configuration Menu
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Using the Configuration Menu

Tools > Firmware

Update File: After you have downloaded the most recent version of the firmware 
from http://support.dlink.com to your hard drive, you can Browse 
your hard drive to locate the downloaded file. Select the file and click 
OK  to update the firmware.
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Using the Configuration Menu

Tools > Cfg File

Update File:

Load Settings to the 
Loacl Hard Drive:

Browse for the configuration settings that you have saved to your 
hard drive. Click OK after you have selected the settings file.

Click OK to save the selected settings to your hard drive.
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Tools > Cfg File > Choose file 

When you click Browse in the previous screen, the dialog box shown above appears.
Select the file you wish to download and click Open. 

The dialog box above will appear as the device restarts. Please wait for a few 
seconds.

Using the Configuration Menu
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Tools > Misc > Telnet Settings

Using the Configuration Menu

Status:

Console Protocol:

Timeout:

Telnet is enabled by default.

Choose between Telnet and SSH.

Select a time period after which a session timeout will occur.

Telnet is a program that allows you to control your network from a single PC.

Tools > Misc > SNMP Settings
Status: SNMP is disabled by default.
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Status > Device Info

Using the Configuration Menu

Device 
Information:

This window displays the settings of the DWL-3200AP, the firmware 
version and the MAC address.
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Status > Stats

Using the Configuration Menu

WLAN 802.11G 
Traffic Statistics:

This window displays the statistics of the IEEE 802.11g network.
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Status > Client Info

Using the Configuration Menu

 
Client Information: Select this option to obtain information on wireless clients. 

(A client is a device on the network that is communicating with the 
DWL-3200AP.)

The following information is available for each client that is communicating with the 
DWL-3200AP.

MAC:

Band:

Authentication:

Signal:

Power Saving 
Mode:

Displays the MAC address of the client.

Displays the wireless band.

Displays the type of authentication that is enabled.

Indicates the strength of the signal

Displays the status of the power saving feature.
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Status > Log

The log information will include, but not limited to, the following items:

• Upgrade Firmware

• Client associate and disassociate with AP

• Web login

If you require more space to hold your logs, please provide the IP address 
of the Server that will store your logs. The embedded memory can only 
have up to 300 logs.

Enter the IP address of the log server.

Check the box for the type of activity you want to log. There are three 
types: System Activity, Wireless Activity, and Notice.

Log Server:

Log Server/IP 
Address:

Log Type:

Using the Configuration Menu
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Help

Using the Configuration Menu

Click on any item in the Help screen for more information.Help:
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Using the AP Manager

Using the AP Manager
The AP Manager is a convenient tool to manage the configuration of your network from a 
central computer. With AP Manager there is no need to configure devices individually.

To launch the AP Manager: 
 • Go to the Start Menu
 • Select Programs
 • Select D-Link AirPremier AP Manager
 • Select DWL-3200AP
 

Click on this button to discover the devices available on the network.

Discovering Devices



54

DWL-3200AP User’s Manual 

D-Link Systems, Inc.

Using the AP Manager

Selecting Devices
The AP Manager allows you to configure multiple devices all at once. To select a single 
device, simply click on the device you want to select. To select multiple devices, hold 
down the Ctrl key while clicking on each additional device. To select an entire list, hold 
the Shift key, click on the first AP on the list and then click on the last AP on the list. 

IP Configuration

You can assign an IP address to an AP or assign IP addresses to multiple 
AP’s by clicking on this button after selecting the device(s).

Select the AP that you want to assign an IP address to and click the IP button. Enter 
the IP address and IP netmask for the selected device and click OK. 

You can configure multiple AP’s with IP addresses all at once. Click on the IP button 
after you’ve selected all of the AP’s you want to assign an IP address. Enter the IP 
address you want to assign the first unit and the AP manager will automatically assign 
sequential IP addresses. 
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Using the AP Manager

Device Configuration

Click on this button to access the configuration 
properties of the selected device(s).

The device configuration window allows you to configure settings but does not actually 
apply the settings to the device unless you click the Apply button. You can also save 
and load configuration files from this window. When you load a configuration file, you 
must click Apply if you want the settings to be applied to the selected device(s).

The save button allows you to save a configuration file of the selected 
device settings. Only settings that have a checkmark next to them 
are saved. You cannot save a configuration file if you selected more 
than one device in the device list. 

The Exit button will close the device configuration window. Any 
settings that haven’t been applied will be lost.

The open button is used to load a previously saved configuration file. 
After opening a configuration file, you must click the Apply button to 
save the settings to the selected device(s).

To save settings to the device, you must click the Apply button. Only 
settings that have a checkmark next to them will be applied.

Refresh will revert to the actual device settings of the selected 
device(s).

The Clear Checks button deselects all configurable options. This 
feature is useful if you only want to change a few settings. Deselect 
all items and only check the items that you want to modify. 

The Check All button will select all configurable options. Any setting 
that has a checkmark next to it is applied to the device or saved to 
the configuration file.

You can configure a single device by highlighting one device in the list, or you can 
configure multiple devices by highlighting multiple devices before clicking on the Device 
Configuration icon pictured above. The examples in this section show single device 
configuration. When you select multiple devices for configuration the procedure will be 
similar.
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Using the AP Manager

When selecting multiple devices for configuration, some options are 
unavailable for configuration by default as noted(*) below:

This allows you to change the device name for the selected 
access point. You must place a checkmark in the Device Name 
box to change the name. This option should only be configured 
when one access point is selected for configuration. 

If you’ve selected one device for configuration and you want 
to change the IP address of the device, check the IP Address 
box. You ca then enter an IP address and Subnet Mask for the 
selected access point. This option should only be configurable 
when one access point is selected for configuration. To configure 
multiple devices with an IP address at one time, please reference 
the previous page. 

Enter the IP address of your gateway, typically your router 
address.

 

 

Device Configuration > General

Device Name(*): 

IP address and 
Subnet Mask(*):

Gateway:
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Using the AP Manager

Device Configuration > General (continued)

This pulldown selection enables or disables the ability to Telnet into  
the selected device(s).

This pulldown selection defines the timeout period during a Telnet 
session with the selected device(s).

DHCP client: There is a pulldown menu to select enabled or disabled. When 
enabled, the selected device(s) will function as a DHCP client(s). 
This allows them to receive IP configuration information from a DHCP 
server. When disabled, the access point(s) must have a static IP 
address assigned to them. 

Telnet Support: 

Telnet Timeout:

Select either Telnet or SSH from the pulldown.Console Protocol:

Select Enable or Disable, Disable is selected by default.SNMP Setting:
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Using the AP Manager

Device Configuration > Wireless 

SSID: The Service Set (network) Identifier of your wireless network. 

Channel:  Allows you to select a channel. 6 is the default setting. 

Wireless: Check to enable wireless mode.

SSID Broadcast: Allows you to enable or disable the broadcasting of the SSID to 
network clients.

Data Rate: A pulldown menu to select the maximum wireless signal rate for the 
selected devices(s).

11g only: To include only 802.11g devices in your network, select this option.

Super G: Select this option to enable a wireless signal rate of up to 108Mbps.

Radio Wave: Select Enable or Disable.

WMM: Select Enable or Disable, Disable is selected by default. WMM 
stands for Wi-Fi Multimedia, by enabling this feature it will improve 
the user experience for audio and video applications over a Wi-Fi 

network. 

Praemble: Select the default value Short and Long, or Long Only.
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Device Configuration > Wireless 

Using the AP Manager

A pulldown menu for selecting the transmit power of the selected 
device(s).

Tx Power:

A pulldown menu to select the maximum wireless signal rate for the 
selected device(s).

Beacons are packets sent by an access point to synchronize a 
network. Specify the beacon value for the selected device(s) here. 
The default value of 100 is recommended.

Date Rate:

Beacon Interval 
(20~1000):

DTIM (1~255): DTIM (Delivery Traffic Indication Message) is a countdown informing 
clients of the next listening window for broadcast and multicast 
messages.

Select this option to automatically select the most optimal channel 
available for wireless networking.

Auto Channel:

This sets the fragmentation threshold (specified in bytes). Packets 
exceeding the value set here will be fragmented. The default is 2346.

Fragment 
Length 

(256~2346): 

The RTS value should not be changed unless you encounter 
inconsistent data flow. The default value is 2346.

RTS Length 
(256~2346):

*Maximum wireless signal rate derived from IEEE Standard 802.11g specifications. Actual data throughput will vary. Network 
conditions and environmental factors, including volume of network traffic, building materials and construction, and network overhead, 
lower actual data throughput rate. Environmental factors may adversely affect wireless signal range.
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Device Configuration > Security > Authentication 

Using the AP Manager
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Access Point

WDS with AP

WDS

Open System
Shared Key
Open System/Shared Key
WPA-Enterprise
WPA-Personal
WPA2-Enterprise
WPA2-Personal
WPA-Auto-Enterprise
WPA-Auto-Personal

Open System
Shared Key
Open System/Shared Key
WPA-Personal
WPA2-Personal
WPA-Auto-Personal

Open System
Shared Key
Open System/Shared Key
WPA-Personal
WPA2-Personal
WPA-Auto-Personal

AP Mode Authentication Available

Device Configuration > Security > Authentication (continued)

Select Open System to communicate the key across the network.
Select Shared Key to limit communication to only those devices that share the same 
WEP settings.
Select Open System/Shared Key to allow either form of data encryption.
Select WPA-Enterprise, WPA2-Enterprise, or WPA-Auto-Enterprise to secure your 
network with the inclusion of a RADIUS server.
Select WPA-Personal, WPA2-Personal, or WPA-Auto-Personal to secure your net-
work using a password and dynamic key changes.
(No RADIUS Server required).

Using the AP Manager
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Device Configuration > Security > Open and Shared

Using the AP Manager

The Security tab contains the WEP configuration settings on the intial page. If you select 
WPA as the authentication type, an additional tab will appear with the WPA configuration 
options based on your selection. 

Authentication 
Type:

Select from the pulldown menu the type of authentication to be used 
on the selected device(s).

 Key Values: 

 Select which defined key is active on the selected device(s).

Select the key size (64-bit, 128-bit, or 152-bit) and key type (HEX 
or ASCII) and then enter a string to use as the key. The key length 
is automatically adjusted based on the settings you choose.

Encryption:  Enable or disable encryption on the selected device(s).

Active Key Index:
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Device Configuration > Security > WPA-Enterprise, WPA2-Enterprise, 
& WPA-Auto-Enterprise

 
Select the interval during which the group key will be vaild. 1800 is the 
recommended setting. A lower interval may reduce transfer rates. 

Cipher Type: Select Auto, AES, or TKIP from the pulldown menu.

Group Key Update 
Interval:

 
Enter the port used on the RADIUS server. 

RADIUS Server: Enter the IP address of the RADIUS server.

RADIUS Port:
 

Enter the RADIUS secret. RADIUS Secret:
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Using the AP Manager

Device Configuration > Security > WPA-Personal, WPA2-Personal, 
& WPA-Auto-Personal

 
Select the interval during which the group key will be valid. 1800 is the 
recommended setting. A lower interval may reduce transfer rates.

Cipher Type: Select Auto, AES, or TKIP from the pulldown menu.

Group Key Update 
Interval:

 
Enter a PassPhrase between 8-63 characters in length.PassPhrase:
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Device Configuration > Filters

Enabling this allows wireless clients to communicate with each other. 
When this option is disabled, wireless stations are not allowed to 
exchange data through the access point.  

When disabled access control is not filtered based on the MAC 
address. If Accept or Reject is selected, then a box appears for 
entering MAC addresses. When Accept is selected, only devices 
with a MAC address in the list are granted access. When Reject 
is selected, devices in the list of MAC addresses are not granted 
access.  

 Internal Station 
Connection: 

 Ethernet to WLAN 
Access:

Enabling this option allows Ethernet devices to communicate with 
wireless clients. When this option is disabled, all data from Ethernet 
to wireless clients is blocked. Wireless devices can still send data to 
the Ethernet devices when this is disabled. 

 Access 
Control: 

Add or Delete MAC addresses in the Access Control List.
 Access 

Control List: 
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Using the AP Manager

Device Configuration > AP Mode

There are 3 AP modes:

 Access Point
 WDS with AP
 WDS
 
Please see the following pages for an explanation of the other 2 AP 
modes.

 Access Point: 
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Using the AP Manager

Device Configuration > AP Mode > WDS with AP

Allows you to connect multiple wireless LANs together, while still 
functioning as an AP. If enabled, you must enter the MAC address 
of the other DWL-3200APs.

 

WDS with AP: 
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Using the AP Manager

Device Configuration > WDS

Allows you to connect multiple wireless LANs together. All other 
LANs must be using DWL-3200APs. When enabled, you must enter 
the MAC address of the other DWL-3200APs. 

WDS: 
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 Enable or disable the DHCP server function. 

 Enter the initial IP address to be assigned by the DHCP server. 

Enter the number of allocated IP addresses.

 Enter the subnet mask.

Enter the gateway IP address, typically a router.

Wins (Windows Internet Naming Service) is a system that determines 
the IP address of a network computer with a dynamically assigned 
IP address, if applicable.

Click to enable Dynamic Pool Settings. Configure the IP address 
pool in the fields below. 

Click to enable Static Pool Settings. Use this function to assign the 
same IP address to a device at every restart. The IP addresses 
assigned in the Static Pool list must NOT be in the same IP range 
as the Dynamic Pool. 

DHCP Server:

Dynamic Pool 
Settings: 

Static Pool 
Settings: 

IP Assigned From:

Range of Pool (1~255): 

SubMask: 

Gateway: 

Wins: 

Using the AP Manager

Device Configuration > DHCP Server

  The IP address of the DNS server, if applicable.

  Enter the domain name of the DWL-3200AP, if applicable.

  The period of time that the client will retain the assigned IP address.

  This option turns the dynamic pool settings on or off.  

DNS:

Domain Name:

Lease Time:

Status:
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Device Configuration > Client Info

  Indicates the strength of the signal.

  Displays the status of the power saving feature.

RSSI:

Power Mode:

Select this option to obtain information on wireless clients. 
(A client is a device on the network that is communicating with the 
DWL-3200AP)

  Displays the MAC address of the client.

  Displays the wireless band.

  Displays the type of authentication that is enabled.

Client Info:

MAC Address:

Band:

Authentication:

Using the AP Manager
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Using the AP Manager

Device Configuration > Rogue AP

The Basic Service Set Type allows you to select from AP BSS, Ad 
Hoc, or Both. 

Select the type of network (bands 11b and 11g) that you would like 
the AP detection to search on. 

BSS Type:

Band:

Select the Security type OFF, WEP, WPA-Enterprise, WPA-Personal, 
WPA2-Enterprise, WPA2-Personal, WPA-Auto-Enterprise, and  
WPA-Auto-Personal that you would like to consider during AP 
detection.

This window shows all of the neighbor APs detected, which is based 
on your criteria from above (BSS Type, Band, and Security). If the 
AP is in the same network, or if you know the AP, just click on “>” to 
save it to the AP list.

This window shows all of the APs that are allowed access on the 
network.

Security:

Rogue AP List:

AP List:
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Device Configuration > Log

Check this option to enable the log and the Remote Syslog Status 
Server IP.

Select Enable to allow the logging of system actions, such as logging 
a firmware upgrade.

Select Enable to allow the logging of any wireless clients that connect 
to the AP.

Select Enable to allow all other information to be logged.

If you require more space to hold your logs, please provide the 
IP address of the Server that will store your logs. The embedded 
memory can only have up to 300 logs.

RemoteSyslogStatus:

System Activity:

Wireless Activity:

Notice:

Remote Syslog 
Status Server IP:

Using the AP Manager
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Device Configuration > Multi-SSID

The DWL-3200AP offers configuration using Multiple SSIDs, allowing for a virtually 
segregated station by sharing the same channel. One primary SSID can be associated 
with up to 7 guest SSIDs. Because guest SSIDs cannot be scanned by site survey 
tools, users cannot associate with guest SSIDs unless they know the exact SSID and 
security setting. The VLAN function can be enabled for both the primary SSID and the 
guest SSID.

Click Save to add the MSSID setting to the table below. Highlight and click Delete to 
remove the MSSID from the table.

Using the AP Manager
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Using the AP Manager

Configuration Files

The DWL-3200AP allows you to save the device settings to a configuration file. To save 
a configuration file follow these steps:
 
 Select a device from the Device List on the main screen of the AP Manager. 

 Click the device configuration button.

 Click the Save button after you have all the settings as you want them.

 A popup window will appear prompting you for a file name and location. Enter the 
file name, choose a file destination, and click Save. 

Device Configuration button.
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You must always click Apply 
in the Configuration window if 
you want the settings to take 
effect.

Using the AP Manager

To load a previously saved configuration file, follow these steps:
 
 Select a device from the Device List on the main screen of the AP Manager. 

  Click the device configuration button.

 Click the Open button.

 A popup window will appear prompting you to locate the configuration file. Locate 
the file and click Open. 

 The configuration file is loaded into the AP Manager but has not actually been 
written to the device(s). If you want to use the newly loaded configuration for the 
selected device(s), click Apply and the configuration settings will be written to the 
device(s).

Device Configuration button.
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Using the AP Manager

To upgrade the firmware:

  Download the latest firmware upgrade from http://support.dlink.com   
   to an easy to find location on your hard drive.

 Click on the firmware button as shown above.

 A popup window will appear. Locate the firmware upgrade file and    
 clickOpen.

You can upgrade the firmware by clicking on this button after 
selecting the device(s).

Firmware







IMPORTANT! DO NOT DISCONNECT POWER FROM THE UNIT WHILE THE 
FIRMWARE IS BEING UPGRADED.
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You can customize the basic System Settings for the 
DWL-3200AP by clicking on this button.

System Settings

 Access Password: This sets the admin password for the selected   
 device(s).
 Auto Refresh: This setting allows you to enable auto refreshing   
 of the network device list. By default this option is disabled. If you   
 choose to enable it, you must enter the refresh interval in seconds.

All other settings on this screen should be left at the default setting.

Using the AP Manager
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Setup Wizard

This button will launch the Setup Wizard that will guide 
you through device configuration.

Click Next.

Using the AP Manager
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Setup Wizard (continued)

Enter a Password and retype it in the Verify Password field.

Using the AP Manager

Click Next.
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Setup Wizard (continued)

Enter the SSID and the 
Channel  for the IEEE 
network.

Using the AP Manager

Click Next.

If you want to enable 
Encryption, enter the 
Encryption values here.

Click Next.
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Setup Wizard (continued)

Using the AP Manager

The DWL-3200AP setup is complete!
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Using the AP Manager

Refresh

Click on this button to refresh the list of 
devices available on the network.

Devices with a checkmark 
next to them are st i l l 
available on the network. 
Devices with an X are no 
longer available on the 
network.

Click on this button to view the 
version of AP Manager.

About
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Using the Network Setup Wizard in Windows® XP

In this section you will learn how to establish a network at home or work, using Microsoft 
Windows® XP. 
 
Note:  Please refer to websites such as http://www.homenethelp.com
and http://www.microsoft.com/windows2000  for information about networking computers 
using Windows® 2000.

Go to Start>Control Panel>Network Connections
Select Set up a home or small office network

Networking Basics

When this screen appears, click Next.

Networking Basics
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Networking Basics

Click Next.

In the following window, select the best description of your computer. If your computer 
connects to the internet through a gateway/router, select the second option as shown.

Click Next.

Please follow all the instructions in this window:
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Networking Basics

Enter a Computer description and a Computer name (optional).

Click Next.

Enter a Workgroup name. All computers on your network should have the same 
Workgroup name.

Click Next.
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Please wait while the Network Setup Wizard applies the changes.

When the changes are complete, click Next.

Please wait while the Network Setup Wizard configures the computer. This may take 
a few minutes.

Networking Basics



87

DWL-3200AP User’s Manual 

D-Link Systems, Inc.

Networking Basics

Insert a disk into the Floppy Disk Drive, in this case drive A.

Click Next.

In the window below, select the option that fits your needs. In this example, Create a 
Network Setup Disk has been selected.  You will run this disk on each of the computers 
on your network. Click Next.
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Please read the information under Here’s how in the screen below. After you complete 
the Network Setup Wizard you will use the Network Setup Disk to run the Network 
Setup Wizard once on each of the computers on your network. To continue click 
Next. 

Networking Basics
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Please read the information on this screen, then click Finish to complete the Network 
Setup Wizard.

The new settings will take effect when you restart the computer. Click Yes to restart 
the computer.

You have completed configuring this computer. Next, you will need to run the Network 
Setup Disk on all the other computers on your network. After running the Network 
Setup Disk on all your computers, your new wireless network will be ready to use.

Networking Basics
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Networking Basics

Naming Your Computer

To name your computer in Windows® XP, please follow these directions.

 Click Start (in the lower left corner of the screen).

 Right-click on My Computer.

 Select Properties and click.

 Select the Computer Name Tab in the System Properties window.

 You may enter a Computer Description if you wish; this field is optional.

 To rename the computer and join a domain, Click Change.



91

DWL-3200AP User’s Manual 

D-Link Systems, Inc.

 In this window, enter the Computer name.

 Select Workgroup and enter the name of the Workgroup.

 All computers on your network must have the same Workgroup name.

 Click OK.

Networking Basics

The wireless adapter-equipped computers in your network must be in the same IP 
Address range (see Getting Started in this manual for a definition of IP Address Range.)  
To check on the IP Address of the adapter, please do the following:

 Right-click on the Local Area Connection icon in the task bar.

 Click on Status.

Checking the IP Address in Windows® XP
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Networking Basics

This window will appear:

 Click the Support tab.

 Click Close.
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Note: DHCP-enabled routers will automatically assign IP addresses to the computers 
on the network, using DHCP (Dynamic Host Configuration Protocol) technology. If you 
are using a DHCP-capable router you will not need to assign static IP addresses.

If you are not using a DHCP capable router, or you need to assign a static IP address, 
please follow these instructions:

 Go to Start.

 Double-click on Control Panel.

Assigning a Static IP Address in Windows® XP/2000

Networking Basics

 Double-click on Network Connections.
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Networking Basics

 Right-click on Local Area Connections.

 Double-click on Properties.

 Click on Internet Protocol (TCP/IP).

 Click Properties.

 Input your IP address and subnet mask. (The IP addresses on your network 
must be within the same range. For example, if one computer has an IP address 
of 192.168.0.2, the other computers should have IP addresses that are sequential, 
like 192.168.0.3 and 192.168.0.4. The subnet mask must be the same for all the 
computers on the network.)
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 Input your DNS server addresses. (Note:  If you are entering a DNS server, you 
must enter the IP address of the default gateway.)

The DNS server information will be supplied by your ISP (Internet Service Provider.)

 Click OK.

Networking Basics

Assigning a Static IP Address in Macintosh® OSX

 Go to the Apple Menu and select System Preferences.

 Click on Network.
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Networking Basics

 Select Built-in Ethernet in the Show pull-down menu.

 Select Manually in the Configure pull-down menu.

 Input the Static IP Address, the Subnet Mask and the Router IP Address in the 
appropriate fields.

 Click Apply Now.
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Networking Basics

 Go to the Apple Menu and select System Preferences.

 Click on Network.

 Select Built-in Ethernet in the Show pull-down menu.

 Select Using DHCP in the Configure pull-down menu.
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Networking Basics

 Click Apply Now.

 The IP Address, Subnet mask, and the Router’s IP Address will appear in a few 
seconds.

Go to Start > Run > type cmd.  A window similar to this one will appear. Type ping 
xxx.xxx.xxx.xxx, where xxx is the IP address of the wireless router or access point. 
A good wireless connection will show four replies from the wireless router or access 
point, as shown.

Checking the Wireless Connection by Pinging 
in Windows® XP and 2000
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Troubleshooting

Troubleshooting
This Chapter provides solutions to problems that can occur during the installation and 
operation of the DWL-3200AP Managed Wireless Access Point. We cover various 
aspects of the network setup, including the network adapters. Please read the following 
if you are having problems.

Note:  It is recommended that you use an Ethernet connection to configure the 
DWL-3200AP .

1. The computer used to configure the DWL-3200AP cannot access the  
Configuration menu.

 Check that the Ethernet LED on the DWL-3200AP is ON. If the LED is not ON, 
check that the cable for the Ethernet connection is securely inserted.

 Check that the Ethernet Adapter is working properly.  Please see item 3  (Check 
that the drivers for the network adapters are installed properly) in this 
Troubleshooting section to check that the drivers are loaded properly.

 Check that the IP address is in the same range and subnet as the DWL-3200AP.  
Please see Checking the IP Address in Windows® XP in the Networking Basics 
section of this manual.

Note:  The IP address of the DWL-3200AP is 192.168.0.50. All the computers on the 
network must have a unique IP address in the same range, e.g., 192.168.0.x. Any 
computers that have identical IP addresses will not be visible on the network. They 
must all have the same subnet mask, e.g., 255.255.255.0.

 Do a Ping test to make sure that the DWL-3200AP is responding. Go to 
Start>Run>Type Command>Type ping 192.168.0.50.  A successful ping will show 
four replies.

Note: If you have changed the default IP address, make sure to ping the correct IP 
address assigned to the DWL-3200AP.
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Troubleshooting

2. The wireless client cannot access the Internet in the Infrastructure mode.

Make sure the wireless client is associated and joined with the correct access point. To 
check this connection:  Right-click on the Local Area Connection icon in the taskbar> 
select View Available Wireless Networks. The Connect to Wireless Network screen 
will appear. Please make sure you have selected the correct available network, as 
shown in the illustrations below.

 Check that the IP address assigned to the wireless adapter is within the same 
IP address range as the access point and gateway. Since the DWL-3200AP has 
an IP address of 192.168.0.50, wireless adapters must have an IP address in the 
same range, e.g., 192.168.0.x.  Each device must have a unique IP address; no two 
devices may have the same IP address. The subnet mask must be the same for all 
the computers on the network.) To check the IP address assigned to the wireless 
adapter, double-click on the Local Area Connection icon in the taskbar > select 
the Support tab and the IP address will be displayed. Please refer to Checking 
the IP Address in the Networking Basics section of this manual.)

 If it is necessary to assign a Static IP Address to the wireless adapter, please refer 
to the appropriate section in Networking Basics. If you are entering a DNS Server 
address you must also enter the Default Gateway Address. (Remember that if 
you have a DHCP-capable router, you will not need to assign a static IP address.  
See  Networking Basics: Assigning a Static IP Address.)
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3.  Check that the drivers for the network adapters are installed properly.

You may be using different network adapters than those illustrated here, but this 
procedure will remain the same, regardless of the type of network adapters you are 
using.

 Go to Start > My Computer > Properties.

Troubleshooting

 Select the Hardware Tab.

 Click Device Manager.
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Troubleshooting

 Double-click on Network Adapters.

 Right-click on D-Link AirPlus DWL-G650 Wireless Cardbus Adapter. (In this 
example we use the DWL-G650; you may be using other network adapters, but the 
procedure will remain the same.) 

 Select Properties to check that the drivers are installed properly.

 Look under Device Status to check that the device is working properly.

 Click OK.
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Troubleshooting

4.  What variables may cause my wireless products to lose reception?

D-Link products let you access your network from virtually anywhere you want. However, 
the positioning of the products within your environment will affect the wireless range.  
Please refer to Installation Considerations in the Wireless Basics section of this 
manual for further information about the most advantageous placement of your D-Link 
wireless products.

5.  Why does my wireless connection keep dropping?

 Antenna Orientation- Try different antenna orientations for the DWL-3200AP. Try to 
keep the antenna at least 6 inches away from the wall or other objects.

 If you are using 2.4GHz cordless phones, X-10 equipment or other home security 
systems, ceiling fans, and lights, your wireless connection will degrade dramatically 
or drop altogether. Try changing the channel on your router, access point and wireless 
adapter to a different channel to avoid interference.

 Keep your product away (at least 3-6 feet) from electrical devices that generate RF 
noise, like microwaves, monitors, electric motors, etc.

6.  Why can’t I get a wireless connection?

If you have enabled encryption on the DWL-3200AP, you must also enable encryption 
on all wireless clients in order to establish a wireless connection.

 Make sure that the SSID on the router and the wireless client are exactly the same.  
If they are not, wireless connection will not be established. 

 Move the DWL-3200AP and the wireless client into the same room and then test 
the wireless connection. 

 Disable all security settings. 

 Turn off your DWL-3200AP and the client. Turn the DWL-3200AP back on again, 
and then turn on the client. 

 Make sure that all devices are set to Infrastructure mode. 

 Check that the LED indicators are indicating normal activity. If not, check that the 
AC power and Ethernet cables are firmly connected.

 Check that the IP address, subnet mask, gateway and DNS settings are correctly 
entered for the network. 

 If you are using 2.4GHz cordless phones, X-10 equipment or other home security 
systems, ceiling fans, and lights, your wireless connection will degrade dramatically 
or drop altogether. Try changing the  channel on your DWL-3200AP, and on all the 
devices in your network to avoid interference.

 Keep your product away (at least 3-6 feet) from electrical devices that generate RF 
noise, like microwaves, monitors, electric motors, etc. 
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7.  I forgot my encryption key.

 Reset the DWL-3200AP to its factory default settings and restore the other devices 
on your network to their default settings. You may do this by pressing the Reset 
button on the back of the unit. You will lose the current configuration settings. 

Troubleshooting
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Technical Specifications

Technical Specifications 
Standards
• IEEE 802.11b
• IEEE 802.11g
• IEEE 802.3
• IEEE 802.3u
• IEEE 802.3x

Device Management
• Web-Based – Internet Explorer v6 or later; Netscape Navigator™ v7 or later; or other Java-enabled 
browsers.
• Telnet
• AP Manager
• SNMP v.3

Data Rates*
For 802.11g:
• 108, 54, 48, 36, 24, 18, 12, 9 and 6Mbps
For 802.11b:
• 11, 5.5, 2, and1Mbps

Security
• WPA2-Enterprise
• WPA2 - Personal 
• WPA-Enterprise
• WPA - Personal 
• 64-,128-,152-bit WEP
• MAC Address Access Control List

Wireless Frequency Range
• 2.4GHz to 2.4835GHz

Wireless Operating Range**
802.11g (Full Power with 5dBi gain diversity dualband dipole antenna)
Indoors: 
• 98ft (30m) @ 54Mbps
• 112ft (34m) @ 48Mbps
• 118ft (36m) @ 36Mbps
• 151ft (46m) @ 24Mbps
• 197ft (60m) @ 18Mbps
• 213ft (65m) @ 12Mbps
• 256ft (78m) @ 9Mbps
• 308ft (94m) @ 6Mbps

Outdoors:
• 279ft (85m) @ 54Mbps
• 656ft (200m) @ 18Mbps
• 1148ft (350m) @ 6Mbps

* Maximum wireless signal rate derived from IEEE Standard 802.11g specifications. Actual data throughput will vary. Network 
conditions and environmental factors, including volume of network traffic, building materials and construction, and network 
overhead, lower actual data throughput rate. Environmental factors may adversely affect wireless signal range.

** Environmental conditions may adversely affect wireless signal range.



106

DWL-3200AP User’s Manual 

D-Link Systems, Inc.

Technical Specifications

Operating Voltage
• 48VDC +/- 10% for PoE

Radio and Modulation Type
For 802.11b:
DSSS:
• DBPSK @ 1Mbps
• DQPSK @ 2Mbps
• CCK @ 5.5 and 11Mbps
For 802.11g:
OFDM:
• BPSK @ 6 and 9Mbps
• QPSK @ 12 and 18Mbps
• 16QAM @ 24 and 36Mbps
• 64QAM @ 48 and 54Mbps
DSSS:
• DBPSK @ 1Mbps
• DQPSK @ 2Mbps
• CCK @ 5.5 and 11Mbps

Transmit Output Power
For 802.11b:
• 158mW (22dBm)
• 79mW (19dBm)
• 40mW (16dBm)
• 20mW (0dBm)
• 1mW (10dBm)

For 802.11g:
• 126mW (21dBm)
• 63mW (18dBm)
• 30mW (15dBm)
• 20mW (12dBm)
• 1mW (0dBm)

Receiver Sensitivity
For 802.11b:
• 1Mbps: -92dBm
• 2Mbps: -90dBm
• 5.5Mbps: -88dBm
• 11Mbps: -85dBm

For 802.11g:
• 1Mbps: -92dBm
• 2Mbps: -90dBm
• 5.5Mbps: -88dBm
• 6Mbps: -88dBm
• 9Mbps: -86dBm
• 11Mbps: -85dBm
• 12Mbps: -85dBm
• 18Mbps: -83dBm
• 24Mbps: -80dBm
• 36Mbps: -76dBm
• 48Mbps: -72dBm
• 54Mbps: -72dBm
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LEDs
• Power
• LAN
• 802.11b/g

Temperature
• Operating: 32ºF to 104ºF (0ºC to 40ºC)
• Storing: -40ºF to 149ºF (-40ºC to 65ºC)

Humidity
• Operating: 10%~90% (non-condensing)
• Storing: 5%~95% (non-condensing)

Certifications
• FCC 
• Wi-Fi

Dimensions
• L = 10.93 inches (277.7mm)
• W = 6.10 inches (155mm)
• H = 1.77 inches (45mm)

Warranty
• 1 Year

Technical Specifications
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Contacting Technical Support

Contacting Technical Support

Technical Support
You can find software updates and user documentation on the D-Link website.

D-Link provides free technical support for customers within the United States and 
within Canada for the duration of the warranty period on this product.  

U.S. and Canadian customers can contact D-Link Technical Support through our    
website, or by phone.  

Tech Support for customers within the United States:
 D-Link Technical Support over the Telephone:
 (877) 453-5465
 Monday to Friday 8:00am to 5:00pm PST

 D-Link Technical Support over the Internet:
 http://support.dlink.com
 e-mail:support@dlink.com

Tech Support for customers within Canada:
 D-Link Technical Support over the Telephone:
 (800) 361-5265
 Monday to Friday 7:30am to 9:00pm EST

 D-Link Technical Support over the Internet:
 http://support.dlink.ca
 e-mail:support@dlink.ca
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Warranty 

Warranty 
Subject to the terms and conditions set forth herein, D-Link Systems, Inc. (“D-Link”) provides this Limited 
Warranty:
• Only to the person or entity that originally purchased the product from D-Link or its authorized reseller or 

distributor, and
• Only for products purchased and delivered within the fifty states of the United States, the District of Columbia, 

U.S. Possessions or Protectorates, U.S. Military Installations, or addresses with an APO or FPO. 
Limited Warranty:  D-Link warrants that the hardware portion of the D-Link product described below (“Hardware”) 
will be free from material defects in workmanship and materials under normal use from the date of original retail 
purchase of the product, for the period set forth below (“Warranty Period”), except as otherwise stated herein. 

• Hardware (excluding power supplies and fans): One (1) year
• Power supplies and fans: One (1) year
• Spare parts and spare kits: Ninety (90) days
The customer's sole and exclusive remedy and the entire liability of D-Link and its suppliers under this Limited 
Warranty will be, at D-Link’s option, to repair or replace the defective Hardware during the Warranty Period at 
no charge to the original owner or to refund the actual purchase price paid.  Any repair or replacement will be 
rendered by D-Link at an Authorized D-Link Service Office.  The replacement hardware need not be new or have 
an identical make, model or part.  D-Link may, at its option, replace the defective Hardware or any part thereof with 
any reconditioned product that D-Link reasonably determines is substantially equivalent (or superior) in all material 
respects to the defective Hardware.  Repaired or replacement hardware will be warranted for the remainder of 
the original Warranty Period or ninety (90) days, whichever is longer, and is subject to the same limitations and 
exclusions.  If a material defect is incapable of correction, or if D-Link determines that it is not practical to repair or 
replace the defective Hardware, the actual price paid by the original purchaser for the defective Hardware will be 
refunded by D-Link upon return to D-Link of the defective Hardware.  All Hardware or part thereof that is replaced 
by D-Link, or for which the purchase price is refunded, shall become the property of D-Link upon replacement or 
refund.
Limited Software Warranty:  D-Link warrants that the software portion of the product (“Software”) will substantially 
conform to D-Link’s then current functional specifications for the Software, as set forth in the applicable 
documentation, from the date of original retail purchase of the Software for a period of ninety (90) days (“Software 
Warranty Period”), provided that the Software is properly installed on approved hardware and operated as 
contemplated in its documentation. D-Link further warrants that, during the Software Warranty Period, the magnetic 
media on which D-Link delivers the Software will be free of physical defects.  The customer’s sole and exclusive 
remedy and the entire liability of D-Link and its suppliers under this Limited Warranty will be, at D-Link’s option, 
to replace the non-conforming Software (or defective media) with software that substantially conforms to D-Link’s 
functional specifications for the Software or to refund the portion of the actual purchase price paid that is attributable 
to the Software.  Except as otherwise agreed by D-Link in writing, the replacement Software is provided only to 
the original licensee, and is subject to the terms and conditions of the license granted by D-Link for the Software.  
Replacement Software will be warranted for the remainder of the original Warranty Period and is subject to the 
same limitations and exclusions.  If a material non-conformance is incapable of correction, or if D-Link determines 
in its sole discretion that it is not practical to replace the non-conforming Software, the price paid by the original 
licensee for the non-conforming Software will be refunded by D-Link; provided that the non-conforming Software 
(and all copies thereof) is first returned to D-Link.  The license granted respecting any Software for which a refund 
is given automatically terminates.
Non-Applicability of Warranty:  The Limited Warranty provided hereunder for Hardware and Software portions 
of D-Link’s products will not be applied to and does not cover any refurbished product and any product purchased 
through the inventory clearance or liquidation sale or other sales in which D-Link, the sellers, or the liquidators 
expressly disclaim their warranty obligation pertaining to the product and in that case, the product is being sold 
“As-Is” without any warranty whatsoever including, without limitation, the Limited Warranty as described herein, 
notwithstanding anything stated herein to the contrary.  

Submitting A Claim:  The customer shall return the product to the original purchase point based on its return 
policy.  In case the return policy period has expired and the product is within warranty, the customer shall submit 
a claim to D-Link as outlined below:
 
• The customer must submit with the product as part of the claim a written description of the Hardware defect 

or Software nonconformance in sufficient detail to allow D-Link to confirm the same, along with proof of 
purchase of the product (such as a copy of the dated purchase invoice for the product) if the product is not 
registered.

• The customer must obtain a Case ID Number from D-Link Technical Support at 1-877-453-5465, who will 
attempt to assist the customer in resolving any suspected defects with the product.  If the product is considered 
defective, the customer must obtain a Return Material Authorization (“RMA”) number by completing the RMA 
form and entering the assigned Case ID Number at https://rma.dlink.com/.

• After an RMA number is issued, the defective product must be packaged securely in the original or other suitable 
shipping package to ensure that it will not be damaged in transit, and the RMA number must be prominently 
marked on the outside of the package.  Do not include any manuals or accessories in the shipping package.  
D-Link will only replace the defective portion of the product and will not ship back any accessories.

• The customer is responsible for all in-bound shipping charges to D-Link.  No Cash on Delivery (“COD”) is 
allowed.  Products sent COD will either be rejected by D-Link or become the property of D-Link.  Products 
shall be fully insured by the customer and shipped to D-Link Systems, Inc., 17595 Mt. Herrmann, Fountain 
Valley, CA 92708.  D-Link will not be held responsible for any packages that are lost in transit to D-Link.  
The repaired or replaced packages will be shipped to the customer via UPS Ground or any common carrier 

https://rma.dlink.com/
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selected by D-Link.  Return shipping charges shall be prepaid by D-Link if you use an address in the United 
States, otherwise we will ship the product to you freight collect. Expedited shipping is available upon request 
and provided shipping charges are prepaid by the customer.

D-Link may reject or return any product that is not packaged and shipped in strict compliance with the foregoing 
requirements, or for which an RMA number is not visible from the outside of the package. The product owner 
agrees to pay D-Link’s reasonable handling and return shipping charges for any product that is not packaged 
and shipped in accordance with the foregoing requirements, or that is determined by D-Link not to be defective or 
non-conforming.
What Is Not Covered: The Limited Warranty provided herein by D-Link does not cover: Products that, in D-Link’s 
judgment, have been subjected to abuse, accident, alteration, modification, tampering, negligence, misuse, faulty 
installation, lack of reasonable care, repair or service in any way that is not contemplated in the documentation 
for the product, or if the model or serial number has been altered, tampered with, defaced or removed; Initial 
installation, installation and removal of the product for repair, and shipping costs; Operational adjustments covered 
in the operating manual for the product, and normal maintenance; Damage that occurs in shipment, due to act of 
God, failures due to power surge, and cosmetic damage;  Any hardware, software, firmware or other products or 
services provided  by anyone other than D-Link; and Products that have been purchased from inventory clearance 
or liquidation sales or other sales in which D-Link, the sellers, or the liquidators expressly disclaim their warranty 
obligation pertaining to the product.  While necessary maintenance or repairs on your Product can be performed 
by any company, we recommend that you use only an Authorized D-Link Service Office. Improper or incorrectly 
performed maintenance or repair voids this Limited Warranty.
Disclaimer of Other Warranties: EXCEPT FOR THE LIMITED WARRANTY SPECIFIED HEREIN, THE PRODUCT 
IS PROVIDED “AS-IS” WITHOUT ANY WARRANTY OF ANY KIND WHATSOEVER INCLUDING, WITHOUT 
LIMITATION, ANY WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NON-
INFRINGEMENT. IF ANY IMPLIED WARRANTY CANNOT BE DISCLAIMED IN ANY TERRITORY WHERE A 
PRODUCT IS SOLD, THE DURATION OF SUCH IMPLIED WARRANTY SHALL BE LIMITED TO THE DURATION 
OF THE APPLICABLE WARRANTY PERIOD SET FORTH ABOVE. EXCEPT AS EXPRESSLY COVERED UNDER 
THE LIMITED WARRANTY PROVIDED HEREIN, THE ENTIRE RISK AS TO THE QUALITY, SELECTION AND 
PERFORMANCE OF THE PRODUCT IS WITH THE PURCHASER OF THE PRODUCT.

Limitation of Liability: TO THE MAXIMUM EXTENT PERMITTED BY LAW, D-LINK IS NOT LIABLE UNDER ANY 
CONTRACT, NEGLIGENCE, STRICT LIABILITY OR OTHER LEGAL OR EQUITABLE THEORY FOR ANY LOSS OF 
USE OF THE PRODUCT, INCONVENIENCE OR DAMAGES OF ANY CHARACTER, WHETHER DIRECT, SPECIAL, 
INCIDENTAL OR CONSEQUENTIAL (INCLUDING, BUT NOT LIMITED TO, DAMAGES FOR LOSS OF GOODWILL, 
LOSS OF REVENUE OR PROFIT, WORK STOPPAGE, COMPUTER FAILURE OR MALFUNCTION, FAILURE OF 
OTHER EQUIPMENT OR COMPUTER PROGRAMS TO WHICH D-LINK’S PRODUCT IS CONNECTED WITH, 
LOSS OF INFORMATION OR DATA CONTAINED IN, STORED ON, OR INTEGRATED WITH ANY PRODUCT 
RETURNED TO D-LINK FOR WARRANTY SERVICE) RESULTING FROM THE USE OF THE PRODUCT, RELATING 
TO WARRANTY SERVICE, OR ARISING OUT OF ANY BREACH OF THIS LIMITED WARRANTY, EVEN IF D-LINK 
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. THE SOLE REMEDY FOR A BREACH OF 
THE FOREGOING LIMITED WARRANTY IS REPAIR, REPLACEMENT OR REFUND OF THE DEFECTIVE OR 
NON-CONFORMING PRODUCT.  THE MAXIMUM LIABILITY OF D-LINK UNDER THIS WARRANTY IS LIMITED 
TO THE PURCHASE PRICE OF THE PRODUCT COVERED BY THE WARRANTY. THE FOREGOING EXPRESS 
WRITTEN WARRANTIES AND REMEDIES ARE EXCLUSIVE AND ARE IN LIEU OF ANY OTHER WARRANTIES 
OR REMEDIES, EXPRESS, IMPLIED OR STATUTORY.
Governing Law:  This Limited Warranty shall be governed by the laws of the State of California. Some states do not 
allow exclusion or limitation of incidental or consequential damages, or limitations on how long an implied warranty 
lasts, so the foregoing limitations and exclusions may not apply. This Limited Warranty provides specific legal rights 
and you may also have other rights which vary from state to state.  

Trademarks:  D-Link is a registered trademark of D-Link Systems, Inc. Other trademarks or registered trademarks 
are the property of their respective owners. 
Copyright Statement:  No part of this publication or documentation accompanying this product may be reproduced 
in any form or by any means or used to make any derivative such as translation, transformation, or adaptation 
without permission from D-Link Corporation/D-Link Systems, Inc., as stipulated by the United States Copyright Act 
of 1976 and any amendments thereto.  Contents are subject to change without prior notice.  Copyright 2005 by 
D-Link Corporation/D-Link Systems, Inc. All rights reserved.

CE Mark Warning:  This is a Class B product. In a domestic environment, this product may cause radio interference, 
in which case the user may be required to take adequate measures.

FCC Statement:  This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against 
harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency 
energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio 
communication. However, there is no guarantee that interference will not occur in a particular installation. If this 
equipment does cause harmful interference to radio or television reception, which can be determined by turning 
the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following 
measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

For detailed warranty information applicable to products purchased outside the United 
States, please contact the corresponding local D-Link office. 
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Product registration is entirely voluntary and failure to complete or return 
this form will not diminish your warranty rights.


